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Information Overload and How to Deal with It 
In the modern world, information arrives mostly through electronic means, at all 

hours of the day and night, no matter where we are or what we are doing, leading 

to information overload.  

Focus and Filter 
The key to battling information overload successfully is to first identify what is the 

most important information that you need to receive, and then develop filters that 

will help you to focus on that information and weed out the less important 

information.  

Give Up Multi-tasking 
Our society has become one in which multi-tasking is seen as a good practice; 

people brag about being “good multi-taskers” and wear their attempts to 
accomplish many different things at once as a badge of honor. Many of those 
people think that they’re being productive or getting a lot done because they’re 

multi-tasking.  
 

But multi-tasking contributes to information overload – how can you help but feel 

overwhelmed when information is coming at you from multiple sources at the same 

time? How can you possibly focus on what is important if you are trying to process 

an email while talking on the phone? 

Multi-tasking wastes time, rather than saving it. Studies show that for over 97% of 

the population, there’s no such thing as multi-tasking. What you’re really doing is 
constantly switching back and forth between two or more tasks.  
 

In his book The Myth of Multi-tasking, Dave Crenshaw calls this “switch-tasking.” 
Switch-tasking is less efficient and costs time; it takes extra time to shift mental 

gears every time you switch between the two tasks, resulting in less efficiency. As 
the complexity and the unfamiliarity of the tasks increases, so does the inefficiency.  
 

The truth is that you can’t accomplish two things which require you to expend 
mental energy at once. You can only do one at a time.  

 
If you’ve ever had the experience of not remembering what you were doing after 
you’ve been interrupted, you know that it takes more time to get things done when 

you try to multitask. In his book Brain Rules, John Medina contends that people 
who are interrupted – and therefore must switch their attention back and forth – 

take 50% longer to accomplish a task. Essentially, multi-tasking is nothing more 
than constantly interrupting the flow of work on one task to replace it with another, 
supporting the theory that what most people call multi-tasking is really switch-

tasking. 
 



 

 

 

What does this have to do with information overload? The more time you waste, 
the more overwhelmed you will feel and the more difficult it will be to focus on the 

most important tasks. 

Tips for Managing Email 
Email may be one of the most difficult forms of communication to master. 

Hopefully, these tips will help. 

Manage Email Expectations 
A frank conversation about when and under what circumstances communication by 

email is appropriate and when clients, colleagues or others should expect to receive 

responses to email messages can work wonders. If you don’t want to respond to 

email messages at night, on weekends, or while you are on vacation, make sure 

you explain that up front – and then stick to your own rules and don’t respond 

during off-hours!  

You can set up an out of office email message that will automatically respond to 

those who email you during off-hours, letting them know that their message was 

received and when they can expect a response. 

Schedule time for email 

Don’t allow email to become a distraction and kill your productivity. Turn off email 

notification sounds and pop-ups. Don’t create more work for yourself and risk losing 

important client messages by going through the same email messages multiple 

times. Don’t read emails first thing in the morning. For most lawyers, urgent 

messages don’t arrive via email overnight or first thing in the morning.  

Schedule a specific time to blast through email after you’ve already tackled your 

most important task of the day, and then at other strategic times throughout the 

day. Be sure to leave sufficient time to review and respond immediately to email 

messages whenever possible.  

If you are waiting for something particularly urgent, or you tend to send urgent 

emails before you arrive at the office, limit yourself to a quick scan of your inbox to 

ensure no urgent messages have arrived and then move on to another task and 

leave the rest for your designated email time. 

Manage your inbox 
Don’t allow yourself to be overwhelmed by your email inbox, but give yourself a 

break. Don’t add extra stress by thinking you need to get to “inbox zero;” it may 

sound good, for most, it’s unrealistic. It’s more important to ensure that you 

manage your inbox so that the most important messages are read and acted upon 

in a timely manner. 



 

 

 

Delete 
Junk messages, coupons, advertisements, list-serve messages and messages about 

upcoming events or programs should be deleted immediately if you are not ready 

to act on them now; new ones are sure to arrive in your inbox tomorrow.  

To eliminate these time-wasters in the future, remove yourself from one email list 

per day until you’re only on lists that you actively participate in or routinely derive 

valuable information from. If you find that you miss being on a list you’ve deleted, 

you can always re-subscribe. 

Delegate 
If the email requires action by someone else, forward it to that person right away 

with a note. Then eliminate the original email from your inbox by deleting it, 

moving it to an alternate folder, or converting it to a task for follow up. 

Respond immediately  
Don’t waste the time you’ve set aside to deal with email by just reviewing 

messages and thinking you’ll go back and respond to them later. It just creates 

extra work, and may result in important client messages getting lost. If you’re 

going to review your emails, respond when you first read the message if possible. 

Saving Email messages - where, why and how 
E-mail was meant to be created and stored on a computer. There is no reason to 

print email messages and save hard copies. If you need to save the message, save 

it electronically.  

Save e-mail messages as you would other correspondence – in the corresponding 

electronic folder, rather than in your inbox, where it may be difficult to locate later. 

You can create folders for reference, for individual projects, etc., or you can use 

add-ins such as OneNote or Evernote to save messages that contain information 

you want to keep track of in other ways. 

If necessary, convert email messages or entire folders to PDF. Adobe Acrobat 

Standard or Professional will create a PDF Portfolio containing a group of email 

messages or even entire Outlook folders, complete with all attachments. Once 

these items are compiled and moved to the client’s folder, they can be removed 

from your email program.  

You may also wish to establish folders within your email program to keep track of 

e-mail correspondence outside of your regular Inbox using folders. You can also 

create rules so that email messages are automatically routed to the correct folders. 

(See Outlook Tips below for more on how to use Outlook Rules)  

For example, you may wish to create separate folders within your email inbox for 

list-serve emails, newsletters, email pertaining to bar association committee 

business, etc. This will help reduce clutter in your main Inbox.  



 

 

 

Beware Reply All 
Have you ever received a group email which was then followed by a seemingly 

endless parade of responses because recipients insisted on using Reply All instead 

of simply Reply? And it’s even more irritating when those responses don’t concern 

you. Don’t be that person.  

Before you hit Reply All, think hard about whether everyone on the original list 

needs to receive your reply. If you want to send a group email, you might consider 

eliminating the option for recipients to choose Reply All as an option.  

When Email Isn’t the Right Tool for the Job 

Know when email is not the appropriate medium for your communication. E-mail is 

fast and easy, but it isn’t always appropriate. Sometimes picking up the phone or 

walking down the hall to see a colleague is a much more efficient way to accomplish 

a task or to get the answer you need than ending up in an endless back-and-forth 

exchange of email messages.  

Email is best used to communicate facts. It can be particularly ineffective for 

sensitive topics, when emotions are involved, or when inflection or tone is 

important. In those instances, a phone call or in-person discussion is probably more 

appropriate.  

Think twice before using email as a method for scheduling meetings, especially 

those with several attendees, as it generates and unproductive string of messages. 

Instead, use a tool created specifically for that purpose, such as Doodle. 

Separate tasks from emails  
If an email represents a task that you need to complete, move it out of your inbox 

and into your tasks folder, or add it to a to-do list or action folder. In Outlook, you 

can drag and drop an email message directly to your Tasks folder, and then 

eliminate the original message. You can also use third-party tools that help you 

manage emails as tasks, such as Toodledo or Remember The Milk.  

Move appointments to your calendar  
If an email represents a deadline or appointment reminder, don’t keep it in your 

inbox – put it where appointments and deadlines belong – on your calendar. And 

then delete the email. (In Outlook, just drag and drop the message to your 

calendar and all the information in the email will stay with the appointment.) 

Email Power Tips 
Separating Business and Personal Email 
Don’t clutter your regular email inbox with newsletters and subscriptions. Create a 

separate account for them on a service such as Gmail so they’re not in the way of 

your most important messages in your Inbox. Make a separate shopping account 

for email for online shopping so that sales promotions and shipping confirmations 

http://doodle.com/
http://www.toodledo.com/
https://www.rememberthemilk.com/


 

 

 

stay out of your business inbox. Tell family and friends not to use your business 

email account for personal messages, jokes, or other non-business purposes. 

Auto Sorting 
One of the newer methods of managing email is by deferring it. Several email apps 

and email services offer the option to defer email for a set period of time. You 

could, for instance, defer an email until tomorrow or Monday and then the email will 

disappear until the designated time. 

Send Effective Email Messages to Get Effective Responses 
One of the best ways to manage your email Inbox is to compose better emails; 

good email messages beget better responses. Write in full sentences, in a 

professional tone, using correct spelling, grammar and punctuation to give the best 

impression possible. 

KISS - Keep it Short and Simple: If you send a lengthy email, expect a lengthy 

response. But if you’re brief, those who respond to you are more likely to be brief in 

response.  

Request a specific response or action: Give email recipients good instructions 

and tell them what you need or expect in return. Ask pointed questions. If there is 

no response required, say so. 

Stick to the Subject (Line): The subject line of your email plays an important 

role in ensuring your message is opened, read and responded to. Make sure the 

subject line doesn’t waste words and that it accurately reflects the content of your 

email.  

If an email conversation veers off-course, or the subject changes mid-stream, edit 

the subject line to reflect the new content of your email. This also makes email 

messages easier to find later. 

Stick to one subject per email message whenever possible. If you must include 

more than one item or subject in your message, indicate that in the subject line, 

separate them (or number them) within the message, and request a specific 

response to each item. 

Use an Email Signature: Ever had to search a sender’s contact information – or 

worse, wasted time trying to figure out their full name – because their email 

message didn’t include an email signature or their email address did not include 

their full name? Creating an email signature is a quick and easy way to make sure 

your email message recipients know who you are and how to contact you. You may 

wish to use a different email signature for different recipients.  



 

 

 

Outlook Tips 
Use the Reading Pane  
Reading emails by clicking on one message after another to open and read them is 

very slow. Using the Reading Pane makes it much easier and quicker. With the 

Reading Pane enabled, you can see and read the content of email messages without 

having to open each message. The Reading Pane seems most effective on the right, 

rather than on the bottom of the screen. 

To find the Reading Pane, go to the View tab, click on Reading Pane in the Layout 

group and choose Right to display the Reading Pane on the right side of your 

screen.  

Because you can view messages without opening each one, you can also set 

Outlook to mark messages as read either when you view or after you view them for 

a specific amount of time by clicking on File-Options-Advanced, and clicking the 

Reading Pane button under Outlook Panes.  

Flag effectively 
Outlook lets you ‘flag’ email messages so that you can easily find messages that 

require special attention. By default, flagging an email turns the flag to the right of 

the message red and also creates a ‘to do’ of that message for today’s date, which 

will appear in Outlook’s To Do bar. But if you receive many emails or have many To 

Dos already, using the default email flag may not be enough to ensure that 

message gets the attention it needs. 

You can change the due date for a flagged message by right-clicking the flag button 

on the message, which will display a list of possible due dates, or you can choose 

Custom to set a specific date. You can also double-click the item to reopen it and 

choose a different due date. But a due date alone may not be enough. In that case, 

you may decide you want to add a reminder to the flagged message, just like 

reminders you get for calendar appointments.  

To add a reminder, right click the flag and choose Add Reminder. A popup will 

display options, including start and due dates, as well as the date and time you 

want to be reminded. 

Once you’ve attended to your flagged message, click the flag again to replace the 

flag with a check mark to show the item has been completed. 

Use Rules 
Outlook uses Rules to automate common tasks. You can create Rules in Outlook to 

do things like move messages from particular senders or with specific subjects to 

specific folders within Outlook, or to automatically flag certain emails for follow up. 

Creating rules is easy. In Outlook 2016, click on File-Rules and Alerts and then New 

Rule to create a new Rule and follow the prompts in the rules wizard. 



 

 

 

You can also create a Rule directly from a message. This is helpful when you’re 

reading a message and you realize that you would like to create a rule that applies 

to all messages with a particular subject line, or to all messages from a particular 

sender.  

For example, you may want to create a folder for all messages that come from your 

bar association list-serve or from a particular individual, and to have all of those 

messages automatically sort into those folders when they arrive in your inbox. To 

do so, simply right-click the message you want to base the rule upon, and click 

Create Rule in the Ribbon under the Home tab. 

Color Coding Email in Outlook 
Color coding incoming messages is one way to easily see when a message from an 

important client has arrived in your inbox. In Mail in Outlook 2013, click the View 

tab and then click View Settings, then Conditional Formatting. Here, you can 

change the color that Unread emails appear in your Inbox (the default is blue), or 

change the font and color of emails in your Inbox. You can also click Add to create 

your own rules for different kinds of emails. 

For example, if you want emails from specific clients to appear in a different color in 

your inbox so you can find them easily, create the rule, choose the font and color 

for the message and then click Conditions to set the conditions for the rule (by 

choosing the client’s name or email address in the “from” field), similar to the way 

you would set up Rules and Alerts in Outlook. 

Creating and Using Outlook Quick Steps 
Some email management tasks are performed repetitively in Outlook, but are not 

appropriate for Rules, because they cannot be automated; they require you to 

make a decision about what to do with the email. In those instances, Quick Steps 

may be the answer.  

Quick Steps are one-click actions to help you manage your Inbox. Quick Steps can 

help you move items to folders, reply and delete, or perform other actions with 

your email messages in just one click. Some Quick Steps are pre-loaded into 

Outlook, but you can create your own Quick Steps as well. 

Quick Steps are located under the Home tab toward the middle of the Ribbon. Click 

on Create New to develop your own. Once your Quick Step is created, it will be 

much easier to act on your email messages. For example, if I want to copy an email 

message from my Inbox to my Action folder (a subfolder I created within Outlook), 

rather than clicking on Move, then Copy to Folder and then choosing my Action 

folder, I can simply click on my Action Quick Step. 

Using Quick Parts to Insert Blocks of Text 
Do you find yourself repeating the same information over and over in email 

messages to different people? Don’t keep reinventing the wheel – use Outlook’s 

Quick Parts (not to be confused with Quick Steps)! 



 

 

 

Lawyers who need to insert large blocks of text into an email message – for 

example, directions to their office, a list of documents clients should bring to their 

first appointment, or answers to frequently asked questions – can do so easily using 

Quick Parts in Outlook.  

First, type the text once into a new email message, then select the text and click 

the Quick Parts icon on the Insert ribbon tab and save it to the Quick Part Gallery 

so it is available for use again in the future. When you want to insert that block of 

text again, click on Quick Parts and choose the appropriate Quick Part to insert. 

Use the Send From Command  
In the File menu of most Windows-based programs, you will find Send From or 

Share command, which enables you to send the item you are working on to another 

person through your default email program without exiting the program you’re 

working in and then going into your email program.  

For example, if you’re working on a Word document and want to send it to a 

colleague for their comments, rather than closing the Word document, opening 

Outlook 2016, clicking on Attach File and searching for the Word document, all you 

need to do is click File from within the Word document, then click Share, and 

choose Email. Then click the option you want (send as attachment, send a link, 

send as PDF). This should open an email window and automatically insert the Word 

document as an attachment. All you need to do is customize the email message 

and hit send. 
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